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SDI-to-MXF Compressed Capture
Benefits of compressed capture
Compressed capture in Vegas® Pro software allows broadcasters and content producers to balance excellent video quality and
reasonable storage requirements.
Uncompressed video capture can be impractical due to extremely large file sizes and slow transfer times. The bandwidth requirements
for storage and transfer of other popular post-production codecs are typically in the 145 Mb/s to 220 Mb/s range. The Sony XDCAM
HD422 format offers a full-raster 1920x1080 4:2:2 image that conforms to the Sony MXF standard, using only 50 Mb/s bandwidth.
MXF files can be used on the Vegas Pro timeline or stored on a server for use at a later time. Because the files conform to the XDCAM
standard, video clips can also be easily transferred to a low-cost, highly versatile Sony Professional Disc media for archiving or
distribution.
The Sony XDCAM MXF format has been adopted by a wide range of third-party broadcast equipment providers, allowing Sony MXF files
to be moved efficiently throughout a production facility, from storage to playout to archive, using a fast, cost-effective IT infrastructure.

Supported SDI cards
•

AJA XENA LH

•

AJA XENA LHe

•

AJA XENA LS

•

AJA XENA LSe

•

AJA XENA 2K*

•

AJA XENA LHi*

•

AJA Io Express**

•

Blackmagic Design DeckLink HD Extreme**

* New in Vegas Pro 9.0a software
** New in Vegas Pro 9.0c software

Supported video formats
•

NTSC Standard (720x486, 29.97 fps)

•

NTSC Widescreen (720x486, 29.97 fps, 16x9)

•

PAL Standard (720x576, 25.00 fps)

•

PAL Widescreen (720x576, 25.00 fps, 16x9)

•

HD 1080-60i (1920x1080, 29.97 fps)

•

HD 1080-50i (1920x1080, 25.00 fps)

•

HD 1080-30p (1920x1080, 29.97 fps)

•

HD 1080-25p (1920x1080, 25.00 fps)

•

HD 1080-24p (1920x1080, 23.976 fps)

Note: Vegas Pro software does not support analog video inputs for SDI cards. However, Vegas Pro software does support component
video output for external preview.

©2009 Sony Creative Software Inc. | 1617 Sherman Ave. | Madison, WI 53704 | 1.800.577.6642 | sonycreativesoftware.com

|1

Supported audio formats
•

48 KHz 16-bit 2 Channels

•

48 KHz 16-bit 4 Channels

•

48 KHz 16-bit 6 Channels

•

48 KHz 16-bit 8 Channels

•

48 KHz 16-bit 10 Channels (DeckLink HD Extreme only)

•

48 KHz 16-bit 12 Channels (DeckLink HD Extreme only)

•

48 KHz 16-bit 14 Channels (DeckLink HD Extreme only)

•

48 KHz 16-bit 16 Channels (DeckLink HD Extreme only)

If you’re using the HDMI input on your AJA card, only two channels of audio are captured.
If you have a DeckLink HD Extreme card, you can use the Blackmagic Design Control Panel in Windows to configure audio inputs.

Supported timecode sources
•

VITC (SD, DeckLink HD Extreme only)

•

HANC (HD, DeckLink HD Extreme only)

•

RS422 (all devices)

Note: Vegas Pro software does not support timecode generation for print to tape.

Synchronization
For AJA cards, Vegas Pro software uses the SDI or HDMI signal with embedded audio to ensure synchronization.
For the DeckLink HD Extreme card, you can use the Blackmagic Design Control Panel in Windows to configure synchronization.

System recommendations
SDI-to-MXF capture
•

2.4 GHz or faster quad-core processor.

•

4 GB or more of RAM.

•

7200 RPM hard drive.

Tip: If your machine does not meet these specifications, consider using the MPEG video quality slider on the General tab of Vegas Pro
Capture Preferences window to adjust performance. For more information, see General tab on page 4.

Uncompressed SD or HD video
•

2.6 GHz or faster multicore processor.

•

Fast hardware-based RAID:
•

25 MB/sec for SD uncompressed 8-bit video

•

120 MB/sec for HD uncompressed 8-bit video

•

175 MB/sec for HD uncompressed 10-bit video

If you’re using an AJA SDI card, you can use the AJA System Test utility to test your RAID transfer speed. See http://www.aja.com/
support/ for support information and downloads for your specific card.
•
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2 GB or more of RAM.
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Compressed capture workflow
The basic workflow for compressed capture is as follows:

1. Configure your SDI card and capture preferences. For more information, see Configuring Capture Preferences on page 3.
2. Capture a single clip, multiple clips, or an entire tape. For more information, see Capturing a single clip or entire tape on page 6 or
Logging multiple clips and performing a batch capture on page 7.

3. Edit your Vegas Pro project using your captured media. For more information, see the Vegas Pro User Manual or the Vegas Pro Online
Help.

4. Export to Sony Professional Disc media (optional). For more information, see Exporting MXF files to Sony Professional Disc media on
page 9.
AJA LHi capture card
HDCAM deck
Deck output to
AJA input for capture

AJA output to deck input
for print-to-tape

Configuring Capture Preferences
Before you begin capturing video, use the Vegas Pro Capture Preferences window to configure your SDI card.

Tip: Connect your deck and power it on before starting Vegas Pro software.
1. From the File menu, choose Capture Video, or click the Capture Video button (

) in the Project Media window. The Capture

Video dialog appears.

2. Select the HDV or SDI radio button and click OK. The Capture window appears.
3. Click the Capture Preferences button (

) in the Capture window to open the Capture Preferences window.

4. On the General tab, begin with the default settings.
If you need to make changes later, see General tab on page 4 for more information about the settings on this tab.

5. On the Device tab, choose AJA Video Device or Blackmagic Design DeckLink from the Device type drop-down list.
6. Confirm that your device is selected in the Device drop-down list.
7. In the Video format and Audio format drop-down lists, select the formats that match the signal connected to the card.
8. Continue with the default settings on the rest of the Device tab.
If you need to make changes later, see Device tab (for AJA Io Express, XENA 2K, LH, LHe, LHi, LS, or LSe SDI cards) on page 5 or Device tab
(for Blackmagic Design DeckLink HD Extreme SDI cards) on page 5 for more information about the settings on this tab.

9. Click OK to close the Capture Preferences window.
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General tab
Item

Description

Stop device on loss of focus

Stops the selected capture device when focus is switched away from the capture application.

Show video when device is stopped

Displays the current frame when the selected capture device is stopped.

Show video when device is fastforwarding and rewinding

Displays video in the capture preview window when you fast-forward or rewind the device.

Add new clips to project media

Select this check box if you want to add captured clips to the Project Media window when
capturing is complete.

Simulate device pixel aspect ratio

Displays square pixels in the Capture Preview window even when the capture format has a
nonsquare pixel aspect ratio.

Fail on dropped frames

Select this check box if you want to stop capturing if a dropped frame is detected.

When capture fails, stop batch capture

Select this check box if you want to stop an SDI batch capture if a dropped frame is detected.

Preroll

Type a value in the box to specify the number of seconds of preroll Video Capture should use for
SDI batch capture.
When you click the Capture Clips button ( ) on the Clip Log tab, Video Capture will seek to a
point prior to your Timecode in setting determined by the number of seconds you enter in the
Preroll box. Video Capture will begin playback at the preroll location, and switch to capture when
it reaches the timecode you specified in the Timecode in box.

Notes:
• Batch capture will fail if there is not enough lead-in time. The deck must be able to find the
timecode that equals the in point minus the preroll duration.
• VITC and HANC timecode sources require less preroll than RS422, as RS422 needs time to
synchronize timecodes with video frames.
Maximum RAM buffer size

Drag the slider to allocate a portion of your system memory as a buffer. During capture, this
buffer is used to prevent dropped frames if your hard disk is unable to write a frame.
The more memory you allocate for a buffer, the longer your computer will be able to handle
difficult stretches of MPEG encoding before it needs to drop frames.

MPEG video quality

When capturing to compressed formats, you can drag the slider to adjust performance. When
you drag the slider to the left, you can increase performance by decreasing video quality. When
you drag the slider to the right, higher-quality video is captured, and more processing power is
required.

Note: Quality settings affect various types of material differently. With some experimentation,
you may find that certain types of scenes can be captured at lower quality settings with little or
no apparent loss of quality. Other material may need the highest possible setting to achieve the
desired quality level.
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Device tab (for AJA Io Express, XENA 2K, LH, LHe, LHi, LS, or LSe SDI cards)
Item

Description

Device type

Choose AJA Video Device.

Device

Choose your device.

Input

Choose SDI or HDMI.

Video format

Choose a setting from the drop-down list to specify the desired video format.

Audio format

Choose a setting from the drop-down list to specify the desired number of channels for
capturing SDI-embedded audio.

Important: Multichannel audio capture is available only if supported by your camera or
deck.
Use progressive segmented frame (psf)
video formats

Select this check box if you want to capture from a device that stores and transfers progressivescan frames by dividing fields.

Use 10-bit encoding

Select this check box if you want to capture 10-bit source material for increased color resolution.
Source material with gradients in the background can benefit from 10-bit encoding.
When you use 10-bit video in your project, choose 32-bit floating point (video levels) from the
Pixel format setting on the Video tab of the Project Properties window.
When the check box is not selected, the captured video will use 8-bit encoding.
Do not select this check box if you want to capture with MXF encoding.

Timecode offset (frames)

If video capture is not frame accurate, type a value in the box or use the spin control to adjust
timecode.

Device tab (for Blackmagic Design DeckLink HD Extreme SDI cards)
Item

Description

Device type

Choose Blackmagic Design DeckLink.

Device

Choose your device.

Video

Choose a setting from the drop-down list to specify the desired video format.

Audio

Choose a setting from the drop-down list to specify the desired number of channels for
capturing SDI-embedded audio.

Important: Multichannel audio capture is available only if supported by your camera or
deck.
Use 10-bit encoding

Select this check box if you want to capture 10-bit source material for increased color resolution.
Source material with gradients in the background can benefit from 10-bit encoding.
When you use 10-bit video in your project, choose 32-bit floating point (video levels) from the
Pixel format setting on the Video tab of the Project Properties window.
When the check box is not selected, the captured video will use 8-bit encoding.
Do not select this check box if you want to capture with MXF encoding.

Timecode source

Choose a setting from the drop-down list to specify the desired timecode source.
• 9-Pin Remote Estimates timecode using the 9-pin RS422 cable from the deck. This format is
more prone to errors than VITC or HANC.
• VITC Uses SMPTE 12M timecode embedded in the video.
• HANC Uses SMPTE RP 188 timecode embedded in the video.

Timecode offset (frames)

If video capture is not frame accurate, type a value in the box or use the spin control to adjust
timecode.

Note: Applies only to RS422 timecode sources.
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Capturing a single clip or entire tape
Tip: Connect your deck and power it on before starting Vegas Pro software.
1. From the File menu, choose Capture Video or click the Capture Video button (

) in the Project Media window. The Capture Video

dialog appears.

2. Select the HDV or SDI radio button and click OK. The Capture window appears.

3. Use the transport controls below the Capture Preview window to cue your video.
4. To encode your video during capture, choose a setting from the Encoding drop-down list. Depending on your input format, the
available encoding formats are as follows:
Input

Encoding

SD SDI

8-bit YUV AVI
IMX MXF

HD SDI

8-bit YUV AVI
HD 422 MXF

10-bit SDI

10-bit YUV AVI

Choose 8-bit YUV AVI or 10-bit YUV AVI for uncompressed capture. Choose IMX MXF or HD 422 MXF for compressed capture.

5. The Capture folder box displays the path to the folder where your video will be saved. You can click the Browse button to choose a
different folder.

6. Click the Start Capture button (
7. Click the Stop button (

) to start capturing.

) to end the capture procedure.

Your clip is saved to the folder specified in the Capture folder box. If you selected the Add new clips to project media check box in
Capture Preferences, the clip is also added to the Project Media window, from which you can add it to the timeline.
If you’ve configured your capture device to capture multiple channels of audio, the audio will be added across tracks when you add
the clip to the timeline. You can open the clips in the Trimmer window to choose which channels you want to use.
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Logging multiple clips and performing a batch capture
Tip: Connect your deck and power it on before starting Vegas Pro software.
1. Use the transport controls below the Video Preview window to cue your video.
2. Click the Clip Edit tab on the right side of Video Capture window and log your clips:

a. In the Clip name box, type the file name you want to use to save the clip.
b. In the Tape name box, type the name of the tape that contains the clip.
c.

In the Timecode in box, type the timecode value that corresponds to the beginning of the clip, or click the Mark Timecode In
button ( ) to use the current frame if you’re cueing with the controls on your deck.

d. In the Timecode out box, type the timecode value that corresponds to the end of the clip, or click the Mark Timecode Out
button ( ) to use the current frame.

Tip: Select the Calculate button ( ) next to the Timecode in, Timecode out, or Length box to prevent editing of that setting
and calculate its value based on the other two timecode values.
e. Click the Add Clip to Log button (
f.

) to add the clip to the Clip Log.

Repeat steps 2a through 2e for each clip you want to capture.

3. To encode your video during capture, choose a setting from the Encoding drop-down list. Depending on your input format, the
available encoding formats are as follows:
Input

Encoding

SD SDI

8-bit YUV AVI
IMX MXF

HD SDI

8-bit YUV AVI
HD 422 MXF

10-bit SDI

10-bit YUV AVI

Choose 8-bit YUV AVI or 10-bit YUV AVI for uncompressed capture. Choose IMX MXF or HD 422 MXF for compressed capture.

4. The Capture folder box displays the path to the folder where your video will be saved. You can click the Browse button to choose a
different folder.

5. Click the Clip Log tab on the right side of Video Capture window.
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6. Click the Capture Clips button (

) and choose a command from the drop-down list to start capturing clips.

Command

Description

Capture all clips

Captures all clips in the log. If a clip has already been captured, it
will be recaptured.

Capture selected clips

Captures all selected clips in the log. Hold Shift or Ctrl to select
multiple clips.

Capture offline clips

Captures all clips with a status of Offline in the log.

If you selected the Add new clips to project media check box, the captured clips are also added to the Project Media list, from
which you can add them to the timeline.
If you’ve configured your capture device to capture multiple channels of audio, the audio will be added across tracks when you add
the clip to the timeline. You can open the clips in the Trimmer window to choose which channels you want to use.

Tips:
• Click the Save Clip Log button (
later time.
• Click the Open Clip Log button (
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) to save the current clip log as an XML file if you want to save your clip log for capture or recapture at a
) and browse to a saved clip log to load a previously saved clip log.

©2009 Sony Creative Software Inc. | 1617 Sherman Ave. | Madison, WI 53704 | 1.800.577.6642 | sonycreativesoftware.com

Exporting MXF files to Sony Professional Disc media
Important: If you are exporting a rendered file to Sony Professional Disc media, the file must precisely conform to the target disc
format, or the export will fail.
1. From the Tools menu, choose Export Video to XDCAM Disc, or click the Export Video to Sony XDCAM Disc button (

) in the

XDCAM Explorer window. The Export Video to XDCAM Disc dialog appears.

2. The XDCAM Device box displays the current XDCAM camera or deck.
If you need to choose a different XDCAM device or transfer method, click the Device button. For more information, see the “Working
with XDCAM” white paper, the Vegas Pro User Manual, or the Vegas Pro online help.

Note: For more information about using your camera deck, refer to its documentation.
3. Choose the file you want to export:
a. Select the Use an existing file radio button.
b. In the File path box, type the path to the file you want to export, or click the Browse button to choose the file you want to
export.

4. Click OK. The selected file is transferred to your camera or deck.

Additional resources
•

Sony Creative Software Inc.

•

AJA Video Systems

•

Blackmagic Design
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